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NOTICES 
 

The material in GeoCue Group, Inc. documents is protected by United States Copyright laws.  

 

 

You may make as many copies of this material for use internal to your 

company as you desire.   Please do not distribute this material outside of your 

company without first discussing with us. 

 

 

Trademarks, Service Marks 
 

 MapObjects and ESRI are trademarks of Environmental Systems 

Research Institute. 

 Windows and .NET are trademarks of Microsoft Corporation. 

 MicroStation is a trademark of Bentley Systems Incorporated. 

 TerraScan is a trademark of TerraSolid Oy. 

 ImageStation and DMC are trademarks of Intergraph Corporation. 

 NIIRS10, GeoCue and CuePac are trademarks of GeoCue Group, Inc. 

 

 

 

 

 

 



 

 

Getting Help 

 
We are sure that you will experience different problems with GeoCue 

that range from installation issues to defects that made it through our 

testing undetected.  We hope that you will immediately contact us with 

any problems or questions and have the patience to work with us 

through a successful GeoCue deployment. 

 

Please contact us via phone or email for assistance with or comments about GeoCue and DMC 

PPS CuePac. 

 

email: 

support@geocue.com 
 

Phone: 

1-256-461-8289 
 

Just ask for GeoCue Support and you will get connected with someone who can assist you.  

There is usually someone in the office between the hours of 0600 and 1800 CDT, USA on 

weekdays.  Weekends are sort of hit or miss. 

 

Fax (always on): 

1-256-461-8249 
 

 

mailto:support@geocue.com
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About this Document 
 

Welcome to the DMC PPS CuePac Version 2017.1 User Guide.  This guide provides background 

on using GeoCue to manage Intergraph’s Digital Mapping Camera (DMC) Post-Processing 

System (PPS) in a GeoCue managed workflow.  This workflow may include from 1 to n nodes 

for PPS processing. 

 

If you are using distributed processing, you may want to refer to the GeoCue Command Dispatch 

System Administrator’s Guide for configuring your system. 

 

The reader of this document is expected to be familiar with the basic GeoCue processing system.  

For information on GeoCue itself, please refer to the GeoCue User Guide. 
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1 Introduction 
 

GeoCue® has teamed with Intergraph Corporation to develop a high performance distributed 

processing workflow for the Digital Mapping Camera Post-Processing System (DMC PPS or 

PPS). This workflow provides: 

 Graphical view of the project area, including context such as raster and vector backdrops  

 Importing of Intergraph’s ImageStation Photogrammetric Manager (ISPM) projects  

 Setup of the DMC post-processing database  

 Use of GeoCue’s distributed processing system to drive DMC radiometric and geometric 

processing across multiple servers in machine or cluster mode  

 Integration of Intergraph’s DMC Image Analysis™ software and management of the 

resulting look-up tables  

 Integration of an image QC step, using Intergraph’s RasView™ application  

 Creation of “on-the-fly” ISPM projects for easy integration into downstream processing 

tools  

 Seamless integration with other GeoCue CuePacs® for workflows such as 

orthorectification and integration with LIDAR projects  

 Integration into GeoCue Project Portal, Project Dashboard and Distributed Project 

Management System for web monitoring and multi-contractor projects  

 

The DMC PPS CuePac integrates into the Enterprise version of GeoCue.  It is assumed that the 

reader of this document is familiar with basic GeoCue operations and that their distributed 

processing system has been configured (see the GeoCue Command Dispatch System 

Administrator Guide).   

 

 

NOTE:  We recommend that Cluster mode processing be used in the GeoCue 

Command Dispatch System for DMC PPS processing. 

 

 

 

 
NOTE:  You will need the DMC Workflow Sample dataset to 
complete these exercises.  You can either ship a USB drive with 
return postage prepaid to GeoCue to obtain this set or purchase 
the data set on a 32 GB flash drive from GeoCue for $100 US.  If 
you elect the flash drive option, the drive is yours to keep. 
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2 Project Creation 
 

The first step in the DMC PPS workflow is the creation of a GeoCue project.  This involves: 

 Naming the project 

 Defining the Environment (the Workflow) 

 Defining the Coordinate System 

 

From the main GeoCue Client menu, select:  Setup ►Project ►New.  This will invoke the 

dialog of Figure 2-1. 

 

 
Figure 2-1:  New Project dialog 

 

 In the ‘Create Project’ dialog, enter a project name and optionally a description.  For this demo, 

we’ll use “Aalen” as the project name.  Under the Available Environments list, select “DMC 

Processing.”  Accept the default values of Default Processing Cloud as All Machines and 

Priority as 1.0. 

 

Note that the sample data set contains an ISPM project entitled “Aa_5cm”.  This is the project 

that we will use in this sample workflow. 
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Click the Select Coordinate System… button.  This will invoke the dialog of Figure 2-2.  Select 

the coordinate system that corresponds to the input data.  For the “Aa_5cm” ISPM project, chose 

the ‘Predefined Horizontal System’ and then browse the Coordinate System Tree via the 

following path: Project Coordinate Systems > National Grids > DHDN 3 Degree Gauss Zone 3.  

For the vertical system, choose “Ellipsoid (Meters)”.  

 

 
Figure 2-2:  Select Coordinate System dialog 

 

 

Project Delete Lock is just a ‘safety’ to keep you from deleting the project accidently.  If you 

check it, you add an extra step in the process required to delete a project. 

 

Click ‘OK’.  The GeoCue Table of Contents (TOC),  in the upper left pane, will now show a new 

layer, named ‘Aalen’.  The coordinate system of this layer is the default for the creation of other 

layers in the project. For the DMC Processing environment, this layer will not have any 

displayable objects (we call these “entities”). 
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3 Import ISPM Project 

 
After creating a project, the first step in processing is to import an ISPM project.  This project 

was typically produced as the output of Z/I Mission Planning. 

 

From the GeoCue menu bar, select Sources ►Import ISPM Project.  This will invoke the dialog 

of Figure 3-1. 

 

 
Figure 3-1:  Import ISPM Project dialog 

 

On the dialog that appears, click the browse button (top-center) and browse to an ISPM project 

created by ZI Mission.  The ISPM project name will appear in the ‘Selected Project ID’ box.  For 

our example, this project is entitled: ‘Aa_5cm’. 

 

Click the ‘Reference’ radio-button. The ‘Reference’ selection for ‘Image files’ will cause 

GeoCue to simply reference paths for any image files that may already exist in the ISPM project.  

Alternatively, ‘Copy to Warehouse’ can be used to have GeoCue copy any existing image files in 

the project into the GeoCue warehouse that is associated with the ISPM project layer.  For a 

DMC processing flow, there will not usually be any existing image files.  
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A DMC ISPM project is represented in GeoCue by four layers: 

 

 Project Boundary – This layer will contain a Minimum Bounding Rectangle (MBR) representing 

the extent of photos in the project. 

 Photo Centers – This layer will contain point graphics for each photo (exposure station) in the 

project.  These are the GeoCue entities that contain processing steps. 

 Strips – This layer will contain line graphics, one for each flight line in the project. 

 Footprints – This layer will contain a rectangular graphic that represents the ground footprint for 

each photo. 

The first ‘Select’ button on the Import dialog opens the layer Selection dialog for the Project 

Boundary layer. If no Project Boundary layers exist, the Create Layer dialog (Figure 3-2) is 

immediately displayed. Enter a name, such as “ISPM Boundaries” and (optionally) a description.  

The coordinate system should be the same as that used for the project.  This is the default value 

used by Create Layer (unless you have intentionally changed the default coordinate system using 

the TOC tools). 

 

 

 
Figure 3-2:  The Create Layer dialog 
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The remaining layers can be created automatically. To do so, check the ‘Auto create component 

layers’ checkbox.   The layer names to be created are displayed, and will be prefixed with the 

ISPM project name.  In the initial release, only the Photo Centers entity type is selectable.  For 

the DMC workflow ‘Photo Center DMC_ISPM’ must be selected.  The other choice, Photo 

Center_ISPM is used for general, non-DMC, ISPM project import. 

 

Finally, browse to a DMC storage unit partition that contains data for this project.  Browse to the 

folder containing the mission folder(s). This is the same folder location as would be browsed 

when using the Intergraph ‘Storage Units and Camera Settings’ dialog. 

 

The dialog as shown in Figure 3-3 is set up and ready to import a project named “Aa_5cm”.  

Photo Centers, Strips, and Footprints layers will be automatically created and named as 

indicated. 

 

 
Figure 3-3:  The Import ISPM Project dialog properly prepared for the example project 

 

 

Click ‘OK’ to begin the project import. The dialog will disappear and the indicated layers will 

display in the GeoCue TOC (Figure 3-4). 
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Figure 3-4:  The GeoCue Table of Contents (TOC) showing the newly created layers 

 

Note that while the project is importing, the back-color of the Visible toggle for the Strips layer 

will appear blue, which represents the GeoCue “in-progress” color. When the import completes, 

the color will change to green, indicating a successful import.  If the back-color should change to 

red, an import error has occurred.  In this event, double click the layer to view the Layer 

Properties dialog.  Select the Processing tab to view any errors that may have occurred (Figure 

3-5). 

 

 
Figure 3-5:  Error message section of the Layer Properties dialog 

 

 

If this is the first graphics to be introduced into the project, you will need to fit the Map View to 

see the result (the globe icon in the main Map View toolbar).  Fitting the Map View for the 

example project will result in the display of Figure 3-6.  Select the Project Boundary in the Map 

View and observe the properties in the Property pane and the checklist in the Checklist pane. 
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Figure 3-6:  The example ISPM project in the Map View 

 

 

Properties on the Project Boundary include:  

 Attributes: 

o ProjectID, 

o Original Path, 

o Flying Height, 

o Average Elevation 

o  Linear Units 

o Angular Units.   

 Files: 

o GeoCue warehouse path to which the ISPM project files were copied. 

The checklist for a boundary is shown in the upper-right pane. The steps will be discussed below. 

 

Figure 3-7 shows a more detailed view of the upper left of the Map View. 
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Figure 3-7: Detailed view of the upper left area of the project 

 

A photo footprint has been selected. At the center of each footprint is a photo center graphic 

(small circle). The green lines represent flight lines; labels turned on (001-006).   

Strip attributes are: ISPM Project ID and ZI Mission name.  There are no active checklist steps 

associated with Flight Lines or Photo Footprints. 

 

Footprint graphics do not have attributes or checklists.  They simply show the extent of coverage 

of the photos.  All photo processing is initiated from the Photo Center entities’ checklists, as 

described below.  Footprints are useful for checking for coverage or gaps, but usually should 

have their visibility set to ‘Off’, as they make the Map View too cluttered.  Toggle the ‘Visible’ 

icon on the footprint layer in the TOC to hide the display of footprints. 

. 

Photo Center entities are named using the ISPM Photo ID from the ISPM project. Strip ID is 

available from the attributes, or by using the labels on the strip graphics in the Map View.  The 

default attributes and checklists are shown in Figure 3-8 and Figure 3-9. 
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Figure 3-8:  Photo Center Attributes 

 

 

 
Figure 3-9:  Photo Center processing checklist 
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3.1 Import of Additional Missions 

Multiple missions, as will occur with multiple days of flying over the same project area, may be 

imported and processed in a single GeoCue project. Since ISPM projects may include photos not 

yet collected, and/or photos collected previously, the Import ISPM module follows these rules 

when importing photos: 

 
1) Photos without acquisition source tags are not imported. 

2) Photos without corresponding raw image data are not imported. 

3) Photos already in the GeoCue project with the same acquisition source tags are not re-

imported. 

Note however that it is possible to import all photos in an ISPM project by selecting the entity 

type ‘Photo Center_ISPM’.  In this case, the three rules identified above are not applied. While 

these particular photo entities cannot be used to drive DMC post-processing, this could be useful 

for viewing planned photos over a project area that will require several flights to complete. As 

collection proceeds, the updated ISPM projects may be imported to separate layers for 

processing. 

4 PPS Initialization 
 

This chapter describes the steps used in initializing the Post-Processing System. 

 

4.1 PPS Database Creation 

 
Once the ISPM project is imported, the first checklist step to be executed is on the Project 

Boundary. Select the Project Boundary and use the ‘+’ tool on the Working Set toolbar to add 

the boundary to the ‘Working Set’.  When selected, the boundary will be highlighted in white; 

once in the Working Set, the boundary changes to yellow.  

 

About the Working Set:  Selecting an entity in GeoCue allows you to see its 

properties and checklist in the properties and checklist panes (lower-left and 

upper-right, respectively). However, to execute a checklist step, you must add an 

entity or group of entities to the Working Set.  The Working Set is the mechanism 

that allows multi-user access to a project, preventing two or more users from 

executing commands on the same data at the same time. 

 

When an entity or entities are in the Working Set, the title bar of the checklist pane changes color 

from red to green and one or more icons at the top of the checklist become active.  The most 

common is the ‘Set State In Progress’ icon – the small square blue icon.  With the ‘Create DMC 

PPS Database’ step highlighted, click this icon (Figure 4-1). 
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Figure 4-1:  The Project Boundary entity in the GeoCue Working Set 

 

This results in the Intergraph DMC PPS dialog being invoked which, for a new project, 

automatically invokes the ‘Storage Units and Camera Settings’ dialog of Figure 4-2. Using the 

Browse button at the upper right of the dialog, browse to the Flight Data Storage (FDS) location 

and calibration folder.  This is usually under the directory “SSD”.  Under SSD, select one of the 

active partitions.  Do not select the actual project name. 
 

Next browse to the Calibration folder using the browse button next to the Calibration Directory 

section of the dialog.  For our example, this directory is called “DMC01-110”. 
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Figure 4-2: DMC PPS Storage Units and Camera Settings dialog 

 

Click ‘OK.’  A new PPS database is constructed from the ISPM project and the FSD data.  

Following this setting, the main PPS dialog is displayed (Figure 4-3). 
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Figure 4-3:  The main DMC PPS dialog 

 

Set the Output Products and Output Options as desired1 and click ‘Close’. Note that the dialog 

can be launched again when needed at other points in the workflow (Section 10:  Modify DMC 

PPS Database checklist step). 

 

Note that if you intend to process intermediate images to a local drive (recommended), the ‘Save 

Intermediate Results’ checkbox should typically be unchecked. See 4.2 Set GeoCue Processing 

Parameters below, for additional details. 

 

Once the dialog is closed, the newly created PPS database is added to the files collection of the 

Project Boundary.  Its path, along with the ISPM project path, is visible from the files tab of the 

GeoCue Properties pane of the Project Boundary (see Figure 4-4). 
 

                                                 
1 See the Intergraph PPS reference documents for details on these settings. 
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Figure 4-4:  File paths after setting up the DMC PPS database 

 

4.2 Set GeoCue Processing Parameters 

 

Add the Project Boundary to the Working Set.  Note - if you’ve just completed the previous step, 

you can use the ‘Restore to Working Set’ tool on the Checklist Processing toolbar to do this 

(curly blue arrow at top right of the checklist pane).  Select the “Set GeoCue Processing 

Parameters” checklist step and click the ‘In Progress’ icon (blue) to start the step. 

 

 
Figure 4-5:  Project Boundary Checklist with the Set GeoCue Processing Parameters step selected 

 

A dialog appears (Figure 4-6) to allow selection of several GeoCue processing options. First, the 

warehouse to be used for storage of the intermediate image files can be selected. The dialog box 

simply lists all available warehouse locations2.  Select the desired warehouse and click OK. 

                                                 
2 GeoCue Warehouses are set up using the GeoCue Server Database Manager tools. 
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Figure 4-6:  Setting the CuePac Processing Options 

 

Alternatively, a performance benefit is possible by selecting the checkbox ‘Process intermediates 

to local storage’. The GeoCue Remote Cache folder (configured during Client set up) will be 

used for writing the intermediate images, rather than using a GeoCue warehouse. Note that you 

must still select a warehouse as an intermediate image location, but this location will only be 

used for recovering from error conditions during geometric processing.  If local intermediate 

storage is used, you should be sure to leave unchecked the  ‘Save Intermediate Results’ option 

on the Intergraph DMC PPS dialog, as not doing so would impose a very large storage 

requirement for the local disks. 

 

Another option also exists for processing the final products to local storage, then when complete, 

copying the products to the final warehouse destination.  Your network and workstation 

configurations will determine if this option is appropriate for you.   However, for most users it is 

recommended this option be left unchecked. 

 

If the ISPM project has references to the DMC video camera thumbnails, the ‘Import Video 

Thumbnails’ option allows the thumbnails to be imported and displayed in the GeoCue Map 

View.  An attempt is made to locate the thumbnail folder. If it cannot be found, you may locate it 

by clicking the browse button to the right of the Thumbnail Folder text box.  You may create a 

raster layer for the thumbnails, or use the default one: “<project name> thumbnails”.  

 

When OK is clicked, the Intermediate image path is constructed based on the warehouse path, 

created if needed, and added to the files collection on the Project Boundary (Figure 4-7), and 

attributes set on the DMC Processing tab to indicate your selected options. 
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Figure 4-7:  Verifying the Intermediate Files storage path 

 

If the Import Video Thumbnails option was selected, you should see the thumbnail images 

appear in the Map View (Figure 4-8). 

 

 
Figure 4-8: Imported Video Thumbnails 

 

4.3 Modify DMC PPS Database 

 

The final step on the Project Boundary checklist is “Modify DMC PPS Database.”  This is an 

Optional step (as indicated by a round, rather than square, step icon).  This step is provided to 
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allow you to change the PPS processing parameters without the need to recreate the PPS 

database.  Normally you will have set the processing parameters during the “Create DMC PPS 

Database” step and will not need to run this step. 
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5 Radiometric and Geometric Processing 
 

5.1 GeoCue Command Dispatch System Configuration 

 

The core of the GeoCue DMC PPS implementation is Radiometric and Geometric processing.  

These steps make extensive use of the GeoCue Command Dispatch System for distributed 

processing.  Your distributed processing system should have been configured prior executing the 

DMC PPS software (see the Command Dispatch System Administrator’s Guide for configuring 

this aspect of GeoCue). 

 

5.2 Processing 

 

Select one or more Photo Center entities and add them to the Working Set.  The Photo Center 

entity checklist appears in the checklist pane as shown in Figure 5-1. Notice the small green 

triangle (arrowhead) superimposed on the step icon for ‘Run Radiometric Processing’.  This 

indicates the next step, ‘Geometric Processing’, will be run automatically when the initial step 

completes.  Due to performance and reliability benefits of running the geometric processing step 

immediately afterward and on the same machine, this behavior has been assigned to the ‘Run 

Radiometric Processing’ step.   

 

NOTE:  Configuration changes can be made to run these steps separately, but is 

beyond the scope of this guide. 

 

 

 
Figure 5-1:  Photo Center Checklist with "Run Radiometric Processing" selected 

 

 

With the ‘Run Radiometric Processing’ checklist step selected, click the ‘In Progress’ (blue) 

icon. If Cloud Processing is set up and enabled, the selected entities will be automatically 



            DMC PPS CuePac User Guide 

DMC PPS CuePac 5-2 5 May 2017 

Copyright 2017, GeoCue Group, Inc. 

dispatched to the available cloud machines for processing. If Dispatch Interactive mode is 

selected, the GeoCue Dispatch dialog will appear (Figure 5-2) and allow you to select from the 

available workstations. 
 

 
Figure 5-2:  Dispatching Radiometric Processing in Workstation mode 

 

Select the workstations (or cloud) and click ‘OK’. Once running the GeoCue Dispatch Manager 

may be used to monitor progress.  You can access the Dispatch Manager dialog from either the 

GeoCue tool tray icon on your desktop or by selecting Setup ►Administration ►Dispatch 

Manager from the GeoCue client window (Figure 5-3). 
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Figure 5-3:  GeoCue Dispatch Manager 

 

If Production State display is enabled, the checklist status of entities can be viewed in the Map 

View, identifiable by the entity outline color (see note below). This color corresponds to the left-

most column of the checklist. Note the checklist step status icon for the selected entity is now 

blue in color, indicating ‘In Progress’ (Figure 5-4). Since the ‘Production State Pending’ icon is 

selected, four other entities are colored purple, indicating they are pending radiometric 

processing. Selecting ‘Production State In Progress’ or ‘Production State Complete’ will color 

entity outlines corresponding to the checklist step currently being run, or last completed, 

respectively. For the ‘In Progress’ case, the default entity color is used for entities which have no 

step in progress. 
 

Note - To enable display of production state, check the ‘Production State (Outline)’ 

column of the photo centers layer in the Table of Contents (TOC).  Also, set the 

‘Production State’ icon on the Symbology toolbar to the desired state, i.e. Complete, In 

Progress, etc., and ensure the ‘Filter by All Users/Machines’ icon is set. 
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Figure 5-4: Radiometric Processing Pending 

 

As radiometric processing completes for individual photos, the ‘Run Geometric Processing’ step 

will start automatically.  When geometric processing completes, product image files will be 

added to the files collection of each entity.  These can be examined by selecting the Ungrouped 

Files horizontal tab of the Files tab in the Property pane (Figure 5-5). 
 

 
Figure 5-5:  The Product images 

 

Also note that the DMC Products attributes in the properties pane are updated to reflect the 

image products that were created (Figure 5-6). 

 



            DMC PPS CuePac User Guide 

DMC PPS CuePac 5-5 5 May 2017 

Copyright 2017, GeoCue Group, Inc. 

 
Figure 5-6:  Product Attributes 

 

As an aid to analyzing any problems that may occur during processing, the log files created by 

the radiometric and geometric processing software are included on the Files tab of the properties 

pane. See the ‘RPP’ and ‘GPP’ Logfiles in the Ungrouped Files tab (Figure 5-7). 

 

 
Figure 5-7: RPP & GPP Logfiles 

 
 

Note – If GPP fails running dispatched, but runs properly using the ‘Run Local’ mode, 

check if the GPP logfile indicates an initialization failure of ImagePipe (IPObj). If so, do 

the following:  Select Control Panel > Administrative Tools >Component Services > 

Computers > My Computer > DCOM Config.  Answer ‘No’ to any warning dialogs, and 

locate ‘Image Pipe API Server’ in the main window. Right-click and select properties. On 

the ‘Identity’ tab, select ‘This user’ and enter the credentials and password exactly as 

used for the GeoCue dispatch service.  Click ‘OK’ and close the remaining opened 

windows. 
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6 Adjusting Processing Parameters 
 

Most DMC post-processing workflows are conducted by processing a few images that are 

representative of the project, adjusting processing parameters and finally processing the entire 

project.  This section of the manual provides the workflow guidance for the integration of the 

DMC PPS image adjustment tools into the GeoCue workflow.  Please see the appropriate 

Intergraph manuals for the details of applying the actual commands. 

 

6.1 Run Image Analysis 

 

Select one or more Photo Center entities that have been geometrically processed and add them to 

the Working Set.  The photo center entity checklist appears in the checklist pane (Figure 6-1). 

 

 
Figure 6-1:  Photo Center entity with Run Image Analysis checklist step selected 

 

With the ‘Run Image Analysis’ checklist step selected, click the ‘In Progress’ (blue) icon.  The 

‘Select Image Type’ dialog will appear as shown in Figure 6-2. 

 

 
Figure 6-2:  Select Image Type dialog 

 

From the list of available output products, select the type you would like to use for running 

Image Analysis, and then click ‘OK’. The DMC Image Analysis application will open with the 

selected images loaded (see Figure 6-3). 
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Figure 6-3:  Image Analysis dialog 

 

Create the Look-up Table (LUT) as desired, and then be sure to select the ‘Save LUT…’ button.  

The save location will already be populated, so simply click ‘Save’, then exit out of DMC Image 

Analyst.  GeoCue will detect that a new LUT was created during the session and prompt you to 

either overwrite an existing named LUT group or to enter a new group name: 
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Figure 6-4:  Saving a LUT group 

 

Once you click ‘Save’, the LUT group will be saved on the GeoCue project, in a warehouse 

location.  It will also be set as an attribute on each of the photo center entities that were selected 

to run this step (Figure 6-5). 
 

 

 
Figure 6-5:  Viewing the LUT group 
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When geometric processing is re-run on these entities, the LUT group will be used for 

processing. The ‘Set LUT Group’ checklist step, described in the section below, can also be used 

to set the LUT attribute of other entities to this, or other saved LUT groups, so that when they are 

geometrically processed, the assigned LUT groups will be used. 

 

The dialog of Figure 6-6 shows the DMC Products properties after geometric processing has 

been run or re-run with a LUT group assigned: 

 

 
Figure 6-6:  The DMC Processing tab showing the applied LUT groups 

 

In this example, the RGB image was reprocessed using the ‘Urban areas’ LUT group, which 

contained only an RGB LUT 

 

6.2 Set DIA LUT 

 

Once you have created Look-Up Tables (LUT) groups using the technique of the previous 

section, you can assign these named LUT groups to Photo Centers. 

 

Select one or more Photo Center entities for which you wish to assign a LUT group. Add these to 

the Working Set.  On the Utility tab, there is a checklist step called “Set LUT Group” (see Figure 

6-7): 
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Figure 6-7:  The Set LUT Group utility step 

 

Select the ‘Set LUT Group’ step, and click the ‘In Progress’ icon. The ‘Set DMC Image Analyst 

LUT’ dialog will open (Figure 6-8): 

 

 
Figure 6-8:  Set DMC Image Analysis LUT dialog 

 

The dialog will be displayed showing a list of all available named LUT groups for this project 

(as created by DIA and described in the previous section).  The LUT group selected from the 

dialog will be saved as an attribute on the selected entities. When the geometric processing step 

is run or re-run on an entity, the LUT attribute for that entity is examined and the LUT group 

used for processing.  This means that potentially, every photo can have a unique LUT 

assignment. 
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6.2.1 Using LUT Groups from other GeoCue Projects 

 

 LUT groups created in other GeoCue projects can be copied to the current project.  LUT groups 

are stored as subfolders in the warehouse folder that corresponds to the GeoCue Project layer 

(GC_PROJECT type).  This folder can be identified by double-clicking the project layer in the 

GeoCue Table of Contents (TOC): ‘Path on Disk’ provides the location.  Simply copy the LUT 

group folder(s) from the source project to the project layer warehouse folder of the current 

project. These LUT groups will appear in the ‘Set DMC Image Analyst LUT’ dialog shown 

above, without the need to run the Image Analysis step.
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7 Individual Image QC 
 

Several strategies are available in the DMC PPS CuePac for checking image quality.  A quick 

method of examining images is by stepping through the images using the built-in GeoCue 

viewer.  A second method is a formal checklist-step driven process of conducting detailed, 

individual image set QC.  Finally, there are additional features especially useful for QC and 

annotation of raster imagery from the GeoCue map view.  The later would require using the 

Import Raster command to load the products into the map view first. Use of the new 

configurable queues for the QC/annotation process is described in detail in the GeoCue User 

Guide. The previously mentioned methods are described in the two sections that follow. 
 

7.1 Quick Check QC 
 

The quick check method uses a GeoCue “named” queue and the built-in raster viewer to quickly 

move through a group of images. 

 

NOTE:  GeoCue defaults to displaying the RGB images created by the DMC PPS.  If you need to QC a 

different image set, you will need to reconfigure the Photo Center entity default viewer using 

Environment Builder. 

 

First, create a named queue by selecting the Queue Manager icon from a Queue toolbar (you 

may need to right click at the top of the Map View in the toolbar area and select “Queue Toolbar 

1” button to activate a queue).    This will display the dialog of Figure 7-1.  Press the New… 

button to open the Queue creation dialog (Figure 7-2). 
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Figure 7-1:  Queue Manager 

 

Give the Queue a name (we use QC in our example) and press OK.  Set the Create New Queue 

options as shown, and press Close to dismiss the Queue Manager toolbar. 

 

 
Figure 7-2:  Create New Queue dialog 

 

If your queue toolbar does not display the newly created queue in the drop-down name space of 

the toolbar, select it by pressing the down arrow next to the name section. 

 

Select the Photo Centers of the images that you wish to review.  Now press the + button on the 

newly created Queue.  This adds the selected Photo Centers to the queue.  The Photo Centers 

added to the queue should now be displayed in green in the Map View window of GeoCue 

Client.   
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Enable the Raster Viewer tool by pressing the RasterVue tool on the View Panes toolbar (Figure 

7-3). 

 

 
Figure 7-3:  Enabling RasterVue 

 

As you advance or step back through the Queue, the associated image will display in RasterVue 

(Figure 7-4).  In addition, the Properties Pane will display metadata associated with the selected 

image.  Please see the GeoCue Workflow Guide if you need additional information about using 

named queues in GeoCue. 
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Figure 7-4:  Displaying a DMC image in RasterVue 

 

7.2 Checklist Driven Image Set QC 

 

Photo Centers in the default configuration of DMC CuePac contain a final processing step 

entitled “Individual Image QC” (Figure 7-5).  This step is linked to the Intergraph application 

“RasView.” 

 

 
Figure 7-5:  Individual Image QC checklist step 

 

This checklist step is started by selecting a single photo center to the Working Set and setting the 

step to ‘in-progress’.  The step launches an image viewer that can be run from the command line. 

The initial implementation uses RasView.exe and it will be started with all product image types 

available in the files collection for the selected Photo Center entity.  Figure 7-6 corresponds to 

the files collection shown in the sections above:  Pan and RGB product images have been 

created. 
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Figure 7-6:  RGB and Pan images displayed in RasView 

 

When the user closes the viewer, the standard GeoCue status dialog appears and allows the status 

to be set and a note recorded for the QC step (Figure 7-7). 
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Figure 7-7:  Processing History dialog 
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8 Miscellaneous Operations 
 

The Project Boundary and Photo Center entities contain several useful Utility operations. 

 

8.1 Set PPS Processing Parameters  

 

The Set PPS Parameters optional processing step on the Project Boundary allows you to change 

the processing parameters after the PPS database has been created (for example, you might want 

to change the image output types). 

 

Add the Boundary entity to the Working Set and set this step In Progress to launch the main 

DMC PPS dialog. This is used for specifying which Output products to create and also for 

setting the Output Options, such as bit depth and compression. 

 

 

8.2  Delete Intermediate Images 

 
The Photo Centers contain a Utility processing step on their checklist that allows you to delete 

the Intermediate PPS images (the images that result from the Radiometric processing step). 

 

This command provides a means to remove only the intermediate images for any or all photo 

center entities in the project.  The entity or entities are placed in the Working Set and the step put 

into progress.  There is no dialog displayed for this step.  Progress can be monitored via the 

Dispatch Manager or entity lock status. 

 

8.3 Export ISPM Project 

 

Photo Centers contain a Utility process step called “Export ISPM Project”.  This is a very useful 

tool that allows creation of ad hoc ISPM projects from a DMC processing project.  This step 

allows an ISPM project to be created and exported to a directory selected by the user.   

 

The step is run by selecting one or more Photo Center entities, placing them in the Working Set 

and setting the step In Progress.  This will display the dialog of Figure 8-1. 
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Figure 8-1:  Export ISPM Project dialog 

 

If more than one product image type exists for the selected entities, the ‘DMC Image Type’ 

combo box will allow the user to select which image type will be used to write to the exported 

ISPM project (i.e. Pan, RGB, CIR, etc.).  Additionally, the user may choose to leave the images 

in the GeoCue warehouse or an export folder may be specified, to which the image files will be 

copied from the warehouse. The paths in the ISPM photo file will be updated accordingly.  
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9 GeoCue Option Settings 

 
The following are the options settings used in these notes.  From the GeoCue menu bar, select 

Setup ► Options ►GeoCue… 
 

 
Figure 9-1:  General GeoCue options 

 

 
Figure 9-2: GeoCue Table of Contents (TOC) settings 
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Figure 9-3:  GeoCue Warning levels 

 

If the ‘Checklist Step Details’ pane is docked in the lower right corner of the GeoCue 

application, click the title, hold down, and drag to the center, to tear off the window.  Resize the 

window so that it appears as follows, then close the window by clicking the red X in the upper 

right corner. The window will appear this size and in this location anytime a checklist step is 

double clicked.  This is more convenient than its default, docked location and size. 

 

 
Figure 9-4:  Positioning the GeoCue Processing History details pane 
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10 Concluding Remarks 
 

We hope that you are finding working with the GeoCue product family to be a significant 

increase in productivity and ease of use.  Hopefully you have not discovered too many software 

defects (bugs).   
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11 Acronyms 
  

CDS Command Dispatch System 

DMC™  Digital Mapping Camera 

  

  

  

ISPM ImageStation Photogrammetric Manager 

  

MBR Minimum Bounding Rectangle 

QC Quality Check 

PPS Post-Processing System 

TOC Table of Contents 

USB Universal Serial Bus 

 

 

 

 


